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& XILINX. Overview

Chapter 1

KC724 IBERT Getting Started Guide

Overview

This document describes setting up the KC724 Kintex®-7 FPGA GTX Transceiver
Characterization Board to run the Integrated Bit Error Ratio Test (IBERT) demonstration
using the Vivado® Design Suite. The designs that are required to run the IBERT
demonstration are stored in a Secure Digital (SD) memory card that is provided with the
KC724 board. The demonstration shows the capabilities of the Kintex-7 XC7K325T FPGA
GTX transceiver.

The KC724 board is described in detail in the KC724 Kintex-7 FPGA GTX Transceiver
Characterization Board User Guide (UG932) [Ref 1].

The IBERT demonstrations operate one GTX Quad at a time. The procedure consists of:
Setting Up the KC724 Board, page 6.

Extracting the Project Files, page 7.

Connecting the GTX Transceivers and Reference Clocks, page 8.

Configuring the FPGA, page 13.

Setting Up the Vivado Design Suite, page 14.

Starting the SuperClock-2 Module, page 17

Viewing GTX Transceiver Operation, page 23.

® N G

Closing the IBERT Demonstration, page 24.
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Requirements

The hardware and software required to run the GTX IBERT demonstrations are:

KC724 Kintex-7 FPGA GTX Transceiver Characterization Board, including;:
®  One SD card containing the IBERT demonstration designs

®  One Samtec BullsEye cable

¢ Eight SMA female-to-female (F-F) adapters

* Six 50Q2 SMA terminators

* GTX transceiver power supply module (installed on board)

e SuperClock-2 module, Rev 1.0 (installed on board)

e Active BGA Heatsink (installed on FPGA)

¢ 12V DC power adapter

* USB cable, standard-A plug to micro-B plug

Host PC with:
e SD card reader
e USB ports

Xilinx® Vivado Design Suite 2014.4

The hardware and software required to rebuild the IBERT demonstration designs are:

Xilinx Vivado Design Suite 2014.4

PC with a version of the Windows operating system supported by Xilinx Vivado
Design Suite

Setting Up the KC724 Board

This section describes how to set up the KC724 board.

Caution! The KC724 board can be damaged by electrostatic discharge (ESD). Follow standard
ESD prevention measures when handling the board, such as using a grounding strap and static
dissipative mat.

When the KC724 board ships from the factory, it is configured for the GTX IBERT
demonstrations described in this document. If the board has been re-configured it must be
returned to the default set-up before running the IBERT demonstrations.

1.

Move all jJumpers and switches to their default positions. The default jumper and
switch positions are listed in the KC724 Kintex-7 FPGA GTX Transceiver Characterization
Board User Guide (UG932) [Ref 1].

Install the GTX transceiver power module by plugging it into connectors J66 and J97.
Install the SuperClock-2 module:

a. Align the three metal standoffs on the bottom side of the module with the three
mounting holes in the SUPERCLOCK-2 MODULE interface of the KC724 board.

b. Using three 4-40 x 0.25 inch screws, firmly screw down the module from the
bottom of the KC724 board.

c.  On the SuperClock-2 module, place a jumper across pins 2-3 (2V5) of the
CONTROL VOLTAGE header, J18, and place another jumper across Si570 INH
header J11.

www.xilinx.com KC724 IBERT Getting Started Guide
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d. Screw down a 50Q SMA terminator onto each of the six unused Si5368 clock
output SMA connectors: 7, J8, J12, J15, J16 and J17.

Extracting the Project Files

The Vivado Design Suite project files required to run the IBERT demonstrations are located
inrdf0184-kc724-ibert-2014-4. zip on the SD card provided with the KC724
board. They are also available online at the Kintex-7 FPGA KC724 Characterization Kit
documentation website.

The zip file contains these files:

e Bit Files
kc724_ibert_qgll5_125.bit
kc724_ibert_gll6_125.bit
kc724_ibert_gll7_125.bit
kc724_ibert_gll8_125.bit

e  Probe Files
kc724_ibert_115_debug_nets.ltx
kc724_ibert_116_debug_nets.ltx
kc724_ibert_117_debug_nets.ltx
kc724_ibert_118_debug_nets.ltx

e Tl Scripts
add_scm2.tcl

setup_scm2_125_00.tcl

The Tcl scripts are used to help merge the IBERT and SuperClock-2 source code (described
in Creating the GTX IBERT Core) and to set up the SuperClock-2 module to run at
125.00 MHz (described in the Setting Up the Vivado Design Suite).

To copy the files from the Secure Digital memory card:

1. Connect the Secure Digital memory card to the host computer.

2. Locate the file rdf0184-kc724-ibert-2014-4.zip onthe Secure Digital memory
card.

3. Unzip the files to a working directory on the host computer.
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Running the GTX IBERT Demonstration

The GTX IBERT demonstration operates one GTX Quad at a time. This section describes
how to test GTX Quad 115. The remaining GTX Quads are tested following a similar series
of steps.

Connecting the GTX Transceivers and Reference Clocks

Figure 1-1 shows the locations for GTX transceiver Quads 115, 116, 117, and 118 on the
KC724 board.

Note: Figure 1-1 is for reference only and might not reflect the current revision of the board.

UG931_c1_01_060313

Figure 1-1: GTX Quad Locations
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Running the GTX IBERT Demonstration

0_CLK_P

All GTX transceiver pins and reference clock pins are routed from the FPGA to a connector
pad that interfaces with Samtec BullsEye connectors. Figure 1-2 A shows the connector
pad. Figure 1-2 B shows the connector pinout.

.5

n] ©

3

w3
5’//

GTX Connector Pinout
UG931_c1_02_080812

GTX Connector Pad

Figure 1-2: A — GTX Connector Pad. B — GTX Connector Pinout

The SuperClock-2 module provides LVDS clock outputs for the GTX transceiver reference
clocks in the IBERT demonstrations. Figure 1-3 shows the locations of the differential clock
SMA connectors on the clock module which can be connected to the reference clock cables.

Note: Figure 1-3 is for reference only and might not reflect the current revision of the board.

i ‘]zv5 £ 1y

HW-CLK-101

- §7 XILINX

(1
° 48 ERMcos

UG931_c1_03_080812

Figure 1-3: SuperClock-2 Module Output Clock SMA Locations

The four SMA pairs labeled CLKOUT provide LVDS clock outputs from the Si5368 clock
multiplier /jitter attenuator device on the clock module. The SMA pair labeled Si570_CLK
provides LVDS clock output from the Si570 programmable oscillator on the clock module.

Note: The Si570 oscillator does not support LVDS output on the Rev B and earlier revisions of the
SuperClock-2 module.

For the GTX IBERT demonstration, the output clock frequencies are preset to 125.000 MHz.
For more information on the SuperClock-2 module, see the HW-CLK-101-SCLK?2
SuperClock-2 Module User Guide (UG770) [Ref 2].
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Attach the GTX Quad Connector

Before connecting the BullsEye cable assembly to the board, firmly secure the blue
elastomer seal provided with the cable assembly to the bottom of the connector housing if
it is not already inserted (see Figure 1-4).

Note: Figure 1-4 is for reference only and might not reflect the current version of the connector.

UG931_c1_04_071812
Figure 1-4: BullsEye Connector with Elastomer Seal

Attach the Samtec BullsEye connector to GTX Quad 115 (Figure 1-5), aligning the two
indexing pins on the bottom of the connector with the guide holes on the board. Hold the
connector flush with the board and fasten it by tightening the two captive screws.

Figure 1-5: BullsEye Connector Attached to Quad 115
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GTX Transceiver Clock Connections

Refer to Figure 1-2, page 9 to identify the P and N coax cables that are connected to the
CLKO reference clock inputs. Connect these cables to the SuperClock-2 Module as follows:

e CLKO_P coax cable - SMA connector J7 (CLKOUT1_P) on the SuperClock-2 Module

¢ CLKO_N coax cable - SMA connector J8§ (CLKOUT1_N) on the SuperClock-2
Module

Note: Any one of the five differential outputs from the SuperClock-2 Module can be used to source
the GTX reference clock. CLKOUT1_P and CLKOUT1_N are used here as an example.

GTX TX/RX Loopback Connections

Refer to Figure 1-2, page 9 to identify the P and N coax cables that are connected to the four
receivers (RX0, RX1, RX2 and RX3) and the four transmitters (TX0, TX1, TX2 and TX3). Use
eight SMA female-to-female (F-F) adapters (Figure 1-6), to connect the transmit and
receive cables as shown in Figure 1-7:

e TX0_P— SMA F-F Adapter —» RX0_P
e TXO0_N — SMA F-F Adapter - RX0_N
e TX1_P— SMA F-F Adapter —» RX1_P
e TX1_N — SMA F-F Adapter » RX1_N
e TX2 P — SMA F-F Adapter - RX2_P
e TX2_N — SMA F-F Adapter » RX2_N
e TX3_P — SMA F-F Adapter - RX3_P
e TX3_N — SMA F-F Adapter - RX3_N

Note: To ensure good connectivity, it is recommended that the adapters be secured with a wrench;
however, do not over tighten the SMAs.

it

UG931_c1_06_080812

Figure 1-6: SMA F-F Adapter
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TX Coax
SMA F-F Adapter
//—RX Coax
, 7 Arg
e : .

UG931_c1_07_080812

Figure 1-7: TX-To-RX Loopback Connection Example

Figure 1-8 shows the KC724 board with the cable connections required for the Quad 115
GTX IBERT demonstration.

(TX/RX Loopback Connections)

UG931_c1_08_080912

Figure 1-8: Cable Connections for Quad 115 GTX IBERT Demonstration
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Configuring the FPGA

This section describes how to configure the FPGA using the SD card included with the
board. The FPGA can also be configured through the Vivado Design Suite using the .bit
files available on the SD card and online (as collection
rdf0184-kc724-ibert-2014-4.zip) at the Kintex-7 FPGA KC724 Characterization
Kit documentation website.

To configure from the SD card:

1. Insert the SD card provided with the KC724 board into the SD card reader slot located
on the bottom-side (upper-right corner) of the KC724 board.

Plug the 12V output from the power adapter into connector ]2 on the KC724 board.

Connect the host computer to the KC724 board using a standard-A plug to micro-B
plug USB cable. The standard-A plug connects to a USB port on the host computer and
the micro-B plug connects to U8, the Digilent USB JTAG configuration port on the
KC724 board.

4. Select the GTX IBERT demonstration with the System ACE™ SD controller SASD CFG
switch, SW8. The setting on this 4-bit DIP switch (Figure 1-9) selects the file used to
configure the FPGA. A switch is in the ON position if set to the far right and in the OFF
position if set to the far left. For the Quad 115 GTX IBERT demonstration, set
ADR2 = ON, ADR1 = ON, and ADRO = ON. The MODE bit (switch position 4) is not
used and can be set either ON or OFF.

SASD CFG

SWs8
ADRO
ADRH1
ADR2
MODE (Not Used)

UG931_c1_09_072412

Figure 1-9: Configuration Address DIP Switch (SW8)

There is one IBERT demonstration design for each GTX Quad on the KC724 board, for a
total of four IBERT designs. Four other demonstration designs are included that show
other board features (the use of these designs are described in the README file within the
SD card). All eight designs are organized and stored on the SD card as shown in Table 1-1.

Table 1-1: SD Card Contents and Configuration Addresses

Demg:;g:““ ADR2 ADR1 ADRO
GTX Quad 115 ON ON ON
GTX Quad 116 ON ON OFF
GTX Quad 117 ON OFF ON
GTX Quad 118 ON OFF OFF
LED Scroll OFF ON ON
DIP Switches OFF ON OFF
Push Buttons OFF OFF ON
USB/UART OFF OFF OFF
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5. Place the main power switch SW1 to the ON position.

Setting Up the Vivado Design Suite

1. Start the Vivado Design Suite on the host computer and click Flow > Open Hardware

Manager (highlighted in Figure 1-10).

File | Flow | Tools Window Help

I ¥ Open Hardware Manager i

VIVADO! 1o s

Quick Start
Create New Project Open Project Open Example Project
Tasks

8 &

Manage IP Open Hardware Manager ¥ilinx Td Store

Information Center

i."i’ ii W 1
Documentation and Tutorials Quick Take Videos Release MNotes Guide

& XILINX

ALL PROGRAMMABLE.

B Td Console

Open the hardware program and debug manager

UG931_c1_10_110314

Figure 1-10: Vivado Design Suite, Open Hardware Manager
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Running the GTX IBERT Demonstration

2. In the Hardware Manager window (Figure 1-11), click Open New Target.

File Edit Flow Tools

Layout View Help

& | iy O BBk X | %x| (3 | 15 Default Layout

e N ®

| Hardware Manager - unconnected

@ Mo hardware target is open.

Open target

I

ad
M
*

Hardware % Auto Connect
QT = | B v E Recent Targets
Mame Sosed Targs

i Open Mew Target..
1|
Properties

« »>Fx

Figure 1-11:

Open a New Hardware Manager

UG931_c1_11_082614

3. An Open Hardware Target wizard opens. Click Next in the first window.

4. In the Hardware Server Settings window, select Local server (target is on local
machine). Click Next to open the server and connect to the Xilinx TCF JTAG cable.
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5. In the Select Hardware Target window, the xilinx_tcf cable appears under Hardware
Targets, and the JTAG chain contents of the selected cable appear under Hardware
Devices (Figure 1-12). Select the xilinx_tcf target and keep the JTAG Clock Frequency
at the default value (15 MHz), click Next.

4. Open New Hardware Target
Select Hardware Target

Select a hardware target from the list of available targets, then set the appropriate JTAG clock (TCK)
frequency. If you do not see the expected devices, decrease the freguency or select a different target.

Hardware Targets

Type Port  MName JTAG Clock Frequency
i _tef | [pigilent/210203367117A |15000000

Hardware Devices (for unknown devices, specify the Instruction Register {IR) length)

Mame IDCode IR Length

& system_ace_cf 0 04001033 8
& xcTk325t 1 43551093 &

Hardware server; localhost: 3121

Finizh | Cancel

UG931_c1_12_082614

Figure 1-12: Select Hardware Target

6. In the Open Hardware Target Summary window, click Finish. The wizard closes and
the Vivado Design Suite opens the hardware target.
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Starting the SuperClock-2 Module

The IBERT demonstration designs use an integrated VIO core to control the clocks on the
SuperClock-2 module. The SuperClock-2 module features two clock-source components:
* Always-on Si570 crystal oscillator

e 5i5368 jitter-attenuating clock multiplier

Outputs from either source can be used to drive the transceiver reference clocks.
To start the SuperClock-2 module:

1. The Vivado Design Suite Hardware window shows the System ACE controller and the
XC7K325T device. The XC7K325T device is reported as programmed. In the Hardware
Device Properties window, enter the file path to the Q115 Probes file
(kc724_ibert_115_debug_nets.ltx) in the extracted IBERT files from the SD card
(Figure 1-13).

Hardware —_ O ® Debug Probes — 0O & %
a < & |[ERd v » | < =[E
Mame Status
E- g localhost (1) Connected
= @@ wilinx_tcf/Digilent/2102033671... Open
(0] Mot programmed

To populate Probes
window, program

Hardware Device Properties - 0O 2 = :

: andjor refresh
« 5|75 device,
& xcTk3I25t_1

Is programmable

Programming file: E] il
|Prnbes file: E]l ‘E
User chain count: 4 u

Properties

UG931_c1_13_031914

Figure 1-13: Adding the Probes File
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2. In the Hardware window, right-click XC7K325T_1 and select Refresh Device
(Figure 1-14).

Note: If the FPGA was not programmed using the SD card, provide both the programming and
the probes files, and then select Program Device.

Hardware Manager - localhostxilinx_tcf/Digilent/2102033671174

@ There are no serial If0 links. Auto-detect links Create links

Hardware — O v = % VIO - hw_vio_1 X
O\. Z % R} E} |,>| [ . Z VIO Probes
Mame Status % O\ Mame Value Activity Direction VIO
E- B localhost (1) Connected = oo
S @ e silinx_tcf/Digllent/21020336711... Open g
i system_ace_cf_0 (0) MfA ¥
—

=

Hardware Device Properties.. . Ctrl+E

o
@ Program Device...
@ Refresh Device
i@

Add Configuration Memory Device. ..

Boot Device...
Hardware Device Properties — O ¢ =
7 Program BER Key...

« 3 |Fk
Clear BER. Key...

@ xc7k325t_1 =ar Y
Program eFUSE Registers., ..
Export to Spreadsheet. ..

=xample.runs/impl_1/example_ibert_7series_gtx_0.bit E] L = =

=xample.runsfimpl_1/debug_nets.|tx E] |i|

'l [ m =

General | Properties

UG931_c1_14_082614

Figure 1-14: Program/Refresh Device
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Running the GTX IBERT Demonstration

3. Vivado Design Suite reports that the XC7K325T is programmed and displays the

SuperClock-2 VIO core and the IBERT core. To configure the SuperClock-2 module,

click Tools > Run Tcl Script (Figure 1-15). In the Run Script window, navigate to the
setup_scm2_125_00. tcl script in the extracted files and click OK.

-

P& 2N

Debug Probes i

Q Gl pig |
g G |

| Smmnnad?

[
*

File Edit Flow | Tools | Window Layout View Help
Pigim il N’ Report =
| Hardware Manag|___Create and Package IP... 7
@ T et St L Run Tel Script...
1 PO i Property Editor Chrl+] [r
QT %E!& Associate ELF Files..,
——— @& Open New Target... =
Lo — COpen Recent Target 3
EI%J[ Program Device . =
..... B Rin Tigge I
..... u 1
< -3 hw Custormize Commands o [
#  Options..,
Hardware Device ProfereEs — 1T
ad L
i xc]“l:';z:ﬁ?_l

D_Examﬁle.runs,."lr.r||:il_.1:|"examp.I.E_.iE:nert_?series _cltx_lil..l:uit

0_example.runsimpl_1/debug_nets. Itx

|

| »

E] |

| General | Properties |

E-3E hw_vio_1

=+1...I% 1[5 T - [F]

- U_scm2fu_vio_sdk2_controlfi2c_ack

-Ag u_scm2fu_vio_sdk2_contralfi2c_done
i1 u_scm2fu_vio_sdk2_controlfpcad_ctrl[5:0]
i u_scm2fu_vio_sdk2_controlfpcal_ctrl[5:0]
-8 u_scm2fu_vio_sdk2_controlfsdk_in[8:0]
g u_scm2fu_vio_sck2_controlfsdk_out[5:0]
~1g u_scm2fu_vio_scdk2_controlfsi5368_done

-1z u_scm2fu_vio_sdk2_control/siS70_done

~Lg u_scm2fu_vio_sdk2_controlfi2c_noreg

~La u_scmZfu_vio_sdkZ_controlfi2c_start

-Lg u_scm2fu_vio_sdk2_controlfsdk2_reset

i u_scm2fu_vio_sdk?_controlfi2c_rd_data[7:0]

t-g u_scm2fu_vio_sdk2_controlfsi5368_freq[19:0]

i u_scm2fu_vio_sdk2_controlfsi570_freq[19:0]
th-Eg u_scm2fu_vie_sdk2_controlfi2c_dev_addr[7:0]

t-Eg u_scm2fu_vio_sck? controlfi2c_reg_addr[7:0]
t-g u_scm2fu_vio_sdk2_controlfi2c_wr_data[7:0]

i85 u_scm2fu_vio_sdk2_controlfpcad_ctrl_1[5:0]
i85 u_scm2fu_vio_sck2_controlfpcal_ctrl_1[5:0]

»

m

85 u_scm2fu_vio_sck?_controlfsclk_out_1[5:0] x

=

85 u_scm2fu_vio_sck?_control/si5363_addr[6:0]

ug931_c1_15_121113

Figure 1-15: Run Tcl Script
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Debug Probes — O

QI

4. To view the SuperClock-2 settings in the VIO core, select the probe signal from the
Debug Probes window and drag it to the VIO-hw_vio_1 window. For example, the
frequencies, ROM addresses, and start signals are selected (Figure 1-16).

Note: The ROM address values for the Si5368 and Si570 devices (i.e., Si5368 ROM Addr and
Si570 ROM Addr) are preset to 19 to produce an output frequency of 125.000 MHz. Entering a
different ROM address changes the reference clock(s) frequency. The complete list of

pre-programmed SuperClock-2 frequencies and their associated ROM addresses is provided in
Table 1-2, page 24.

I
#

(@

t-6g u_scm2fu_vio_sclk2_controlfpca_ctrl[5:0] -
t-t5 u_scm2fu_vio_sdk?_controlfpcal_ctri[5:0]

H-5 u_scm2fu_vio_sck2_controlfzsclk_in[8:0]

£} ’@ u_scm2fu_vio_sdk2, controlfsdk out[5 D]

--La u_scm2fu_vio_sck2 controlfzc _noreg

[-%g u_scm2fu_vio_sdk?2_controlfi2c_reg_addr[7:0]
g u_scm2fu_vio_sdk2_controlfi2c_start

%5 u_scm2fu_vio_sdk?_controlfi2c_wr_data[7:0]
t-&g u_scm2fu_vio_sck?_controlfpcal_ctrl_1[5:0]

t-tg u_scm2fu_vio_sdk2_controlfpeal_cirl_1[5:0]

-l U_scm2fu_» vio _=zclk2_controlfsck2_reset

m

AEQu_scm2ju_vio_sdk?_control f=i5358_ addr[u 0]

=1 u_smzfu_\ﬂo_sdkz_controh’m5368_dkwr
H-Eg u_scm2fu_vio_sclk2_control/si5368_dsbl[4:0]

J& VIO - hw_vio_1 x]

VIO Probes

’Ck MName
[===]

[ [k B4

[/

e
g

At lu =cm2fu vio Qde control/si570 start

= u_scm2fu_vio_sdk?_control/si5368_freq[19:0] |[U] 125000
= u_scm2fu_vio_sdk2_controlfsis70_freq[19:0] [[U] 125000
u_scmZfu_vio_sdk2_controlfsis368_addr[6:0] |[U] 19

u_scmZfu_vio_sdk2_control/si570_addr[5:0]
u_scm2fu_vio_sdk?_controlfsi5368_start
u_scm2fu_vio_sdk2_controlfsi570_start

Value Activity Direction

K - The Frequency for both clocks is set to 125 MHz

g - The ROM address value for the Si5368 and Si570
7 is set to 19(125 MHz)

/ - Si5368 and Si570 start button (clock starts on rising edge)

UG931_c1_16_101813

Figure 1-16: SuperClock-2 Module VIO Core
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Running the GTX IBERT Demonstration

5. To view the GTX transceiver operation, click Layout > Serial I/O Analyzer. From the

top of the Hardware Manager window, select Auto-Detect Links to display all

available links automatically. Links can also be created manually in the Links window
by right-clicking and selecting Create Links, or by clicking the Create Links button

(Figure 1-17).

@ There are no serial 1/0 links. !Auto-detect links Create Iinksl

Hardware iz [l [ Debug Probes AL | A P
o = e R o = |
az=ER»E Q E
Mame Status [#i8 u_scm2fu_vio_sdk2_controlfsdk_out[5:0] o
R AALL 3L L , - 1m U_scm2fu_vio_sclk2_controlfsis368_done
--3§ IBERT (IBERT) [ u_sem2fu_vio_sclk2_control/si5368_freq[19:0]
=8y Quad_115 (5) g u_scm2ju_vio_sdk2_control/si570_done
[] CoMMON_X0YD Locked iz [ u_scm2fu_vio_sdk2_controlfsi570_freq[19:0]
i By MGT_XOYO 12,500 Gbps [#hg u_scm2fu_vio_sck2_controlfiZc_dev_addr[7:0] —
2 MGT_X0Y1 12,500 Gbps E L u_scm2fu_vio_sck2_controlfi2c_noreg
: B MGT_x0¥2 12,500 Gbps [#hg u_scm2fu_vio_sck2_controlfi2c_reg_addr[7:0]
P B2y MGT_x0¥3 12,500 Gbps - g u_scm2fu_vio_sdk2_controlfi2c_start
1 5% hw vio 10V 'L;" oK g &= -4 u_sem2ju_vio_sck2_controlfi2e_wr_data[7:0]
_________ %5 u_scm2fu_vio_sck2_controlfpca0_ctrl_1[5:0]
VIO Core Properties e i A (%5 u_scm2fu_vio_sdk2_controlfpcal_ctrl_1[5:0]
i g u_scm2fu_vio_sdk2_controlfsdk2_reset
L -&:h & [#hg u_scm2fu_vio_sck2_controlfedk_out_1[5:0] E
SE hw_vio_1 [#hg u_scm2fu_vio_sck2_control/si5368_addr[5:0]
kg u_scm2fu_vio_sck2_controlfsi5368_dkin[1:0]
Name: hw_vio_1 L u_scm2fu_vio_sck2_controlfsi5368_dkwr
) g u_scm2fu_vio_sck2_controlfsi5368_dsbl[4:0]
Device: % xc7k325t 1 -l u_scm2fu_vio_sdk2_controlfsi5368_reset
Refresh rate (ms): 500 - a u_stm2fu_vio_sclk2_control/5i5368_start
kg u_scm2fu_vio_sdk2_control/si570_addr[g:0]
%5 u_scm2fu_vio_sdk2_control/si570_idcode[:0] 4
g u_scm2fu_vio_sdk2_controlfsi570_recal -
| General | Properties | tela u_sem2ju_vio_sdk2_controlfsi570_start =]
Serial 1/O Links
‘3\| MName T Status Bits Errors EER BERT Reset  TX Pattern
=
b 3 Ctrl+E
E% a
rf’..! X Delete Delete
ok
| 3] @ Create Links... I
¥ Create I.-'-\ub:-detectlinks or ceate links to add s
c.: w
ﬁ",’i e
R L _ _ _ d = it i
T B Td Console | © N Export to Spreadsheet... Scans__!

UG931_c1_17_031914

Figure 1-17: Serial I/O Analyzer - Create Links
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6. Iflinks are created manually, the Create Links window is displayed. The options in this
window are used to link any TX GT to any RX GT. To create links, select the TX GT and
RX GT from the two lists then click the Add (+) button. For this project, connect the
following links (Figure 1-18):
¢  MGT_X0Y0/TX to MGT_X0Y0/RX
¢ MGT_X0Y1/TX to MGT_X0Y1/RX
¢ MGT_X0Y2/TX to MGT_X0Y2/RX

e MGT_X0Y3/TX to MGT_X0Y3/RX

J Create Links ==

|ﬂ] To create a new link select a TX GT andjor an RX GT, then dick the Add Link button.
L 1

New Links

Description T RX

Delete Links

Create link group
Link group description: | Link Group D|
[¥] Open Serial If0 Analyzer layout

UG931_c1_18_031914

Figure 1-18: Create Links Window
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& XILINX. Running the GTX IBERT Demonstration

Viewing GTX Transceiver Operation

After completing step 6 in Starting the SuperClock-2 Module, the IBERT demonstration is
configured and running. The status and test settings are displayed on the Links tab in the
Links window shown in Figure 1-19.

Note the line rate and RX bit error count:

e The line rate for all four GTX transceivers is 12.5 Gb/s (see MGT Link Status in
Figure 1-19).

¢ Verify that there are no bit errors.

File Edit Flow Tools Window Layout View Help Seardh commands
AR R W X | | E | X serna 10 analyzer b £ 3 Y

Hardware Manager - localhost/xiinx_tcfiDiglent/210203367117A 4
Hardware — 0O % Debug Probes — 0O % % VIO - hw_vio_1 X O x
o Z=ER M »E & T =|[E | viorrobes % 0Ox
Name Status = hw_vio_t A1 =] A Name Vlue  Actvity Direcon VIO
s B o '": ”—5‘"‘3“—“‘°—5‘:E—‘°”§°:”fz—z"‘ (3 D © 15 u_sandju v ke contois363_freq[13:0] 1] 125000 mput  Fwvie_t
El, u_scm2/u_vio_sck2_controlfi2c_done : B i o
1% Quad_115 (5) s san2iu vio_sck? controlfize d_deta[7:0] % & u_scm2/u_vio_sclk2_control/si570_freq[19:0] [U] 125000 Input hw_vio_1
COMMON XOYD  Locked uiscmZjuiwnisdklicnnwnlf E;ﬂ EU\[S‘EI]. 5 u_sam2fu_vio_sck2_control/si5368_addr[6:0] [U] 15 ~ Output hwy_vio_1
Py MGT, XDYD_ 12.500 Ghps :-: u_scmZ[u_ku_sdkl_cuntulfscal_ctr\[SIU] X g u_scm2fu_vio_sclk2_control/si570_addr[6:0] [U] 18 ~ Output hw_vio_1
By MGT_X¥0Y¥1 12,500 Gbps L -ig u:scmZj'u:wn:sdkz:cnnwnlfsclk_\;\[B:EI] Eu e u_san2ju_vio_sck2_control/i5365.start o ~ Output f_vio_1
by MGT_X0Y2 12.500 Ghps E o u_samzfu_vio_edk?_conroljsck_out w[s0] = La u_scm2fu_vio_sclk2_control/si570_start Blo - Output hw_vio_1
B MGT_X0Y3 12.500 Gbps B e u_sem2fu_vio_schk2_control/si5368_dane
hw_vio_1 (IO} QK 2 g u_scm2/u_vio_sck2_control/si5368_freq[19:0]
= = T o % -1z u_scm2fu_vio_sck2_control/si570_done
araware Device Properties -b & u_scm2/fu_vio_sclk2_control/si570_freq[19:0]
&= = E) % -5 u_scm2fu_vio_scdk2_controlfi2c_dev_addr[7:0]
@ w3251 - g u_sem2ju_vio_sclk?2_controli2c_noreg R
-4 u_scm2/u_vio_sdk2_control/i2c_reg_addr[7:0]
-
Name: k325t 1 Ea La u_scm2fu_vio_sck2_controlfi2c_start
= g u_scm2/fu_vio_sclk2_controlfi2c_wr_data[7:0]
Part: X735t -5 u_scm2ju_vio_sclk2_control/pcal_ctrl_1[5:0]
ID code: 43651093 g u_sem2ju_vio_sck2_control/pcal_ctrl_1[5:0]
10 lannth: 3 d g u_sem2fu_vio_schk2_control/sck2_reset
il > -5 u_scm2fu_vio_sck?2_controlfsdk_out_w_1[5:0] _
General | Properties q - = e —
Serial 10 Links — O =
Q| Name ™ RX Status Bits Errors | BER BERT Reset | TX Pattern RX Pattern TXPre-C... TXPost-.. TXDiffSwing DFE... TXReset RXReset |RXPLL... TXPLL 5tal
:Z + [ Ungrouped Li...
i | B Link Group 0 (4) Reset  |PRBS 31-bit v PRBS 31bit + 167d... ~ 0.68d... ¥ 269mV (0000) ~ Reset Reset
= % Link 0 MGT_X0Y0Q/T% MGT_x0Y0/Rx |12.500 Gbps| 2.072E1. 0EQ|4.826E-14] Reset |PRBS 31-hit ~ PRBS 31-bit ~ 167d.. ~ 0.68d.. ~ 269 mV (0000) ~ Reset Reset |Locked Locked
! S Link 1 MGT_X0Y1/TX MGT_X0Y1/RX |12.500 Gbps| 2.072E1. 0EO| 4.826E-14} Reset PRBS 31-bit ¥ PRBS 31hit v 1.67d... ¥ 0.68d... ¥ 269mV (0000) ~ Reset Reset |Locked Locked
\ﬂj “b Link 2 MGT_x0Y2/T¥ MGT_x0v2/R% |12.500 Gbps| 2.072E1. 0EQ|4.826E-14] Reset  |PRBS 31-hit * PRBS 31-bit v 167d.. » 0.68d... ¥ 269mV {0000) ~ Reset Reset  JLocked Locked
" -Gy Link 3 MGT_X0Y3/TX MGT_X0Y3/R¥ |12.500 Gbps| 2.072E1. OEO|4.826E-14] Reset  |PRBS 31-bit v PRBS 31hit ~ 1.67d.. ~ 0.68d... v 269 mV (0000) ~ Reset Reset |Locked Locked
@

| ] 3

5 Td Console | () Messages., % Serial 1/0 Links | [E] Serial /O Scans

UG931_c1_19_051414

Figure 1-19: Serial I/O Analyzer Links
In Case of RX Bit Errors

If there are initial bit errors after linking, or as a result of changing the TX or RX pattern,
click the respective BERT Reset button to zero the count.

If the MGT Link Status shows No Link for one or more transceivers:

* Make sure the blue elastomer seal is connected to the bottom of the BullsEye cable and
the cable is firmly connected and flush on the board.

* Increase the TX deferential swing of the transceiver (to compensate for any loss due to
PCB process variation).

® Click the respective TX Reset button followed by BERT Reset.
Additional information on the Vivado Design Suite and IBERT core can be found in Vivado

Design Suite User Guide: Programming and Debugging (UG908) [Ref 3] and in LogiCORE IP
Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers Product Guide for Vivado
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Design Suite (PG132) [Ref 4].

Closing the IBERT Demonstration
To stop the IBERT demonstration:

1.

Close the Vivado Design Suite by selecting File > Exit.

2. Place the main power switch SW1 in the off position.

SuperClock-2 Frequency Table

Table 1-2 lists the addresses for the frequencies that are programmed into the SuperClock-2
read-only-memory (ROM).

Table 1-2: Si570 and Si5368 Frequency Table

Address Protocol Fr?'c\|nt||_lezr;cy Address Protocol Fr‘:ﬁn‘:ﬂ;cy Address Protocol Fr?'(\]nthezr)lcy
0 100GE/40GE/10 1 161130 30 OBSAI 307.200 60 XAUI 156.250
1 Aurora 81.250 31 OBSAI 614.400 61 XAUI 312.500
2 Aurora 162.500 32 0OC-48 19.440 62 XAUI 625.000
3 Aurora 325.000 33 0OC-48 77.760 63 Generic 66.667
4 Aurora 650.000 34 0OC-48 155.520 64 Generic 133.333
5 CE111 173.370 35 0OC-48 311.040 65 Generic 166.667
6 CPRI™ 61.440 36 0OC-48 622.080 66 Generic 266.667
7 CPRI 122.880 37 OTU-1 166.629 67 Generic 333.333
8 CPRI 153.630 38 OTU-1 333.257 68 Generic 533.333
9 CPRI 245.760 39 OTU-1 666.514 69 Generic 644.000
10 CPRI 491.520 40 OTU-1 666.750 70 Generic 666.667
11 Display Port 67.500 41 OTU-2 167.330 71 Generic 205.000
12 Display Port 81.000 42 OTU-2 669.310 72 Generic 210.000
13 Display Port 135.000 43 OTU-3 168.050 73 Generic 215.000
14 Display Port 162.000 44 OTU-+4 174.690 74 Generic 220.000
15 Fibrechannel 106.250 45 PCle® 100.000 75 Generic 225.000
16 Fibrechannel 212.500 46 PCle 125.000 76 Generic 230.000
17 Fibrechannel 425.000 47 PCle 250.000 77 Generic 235.000
18 GigE 62.500 48 SATA 75.000 78 Generic 240.000
19 GigE 125.000 49 SATA 150.000 79 Generic 245.000
20 GigE 250.000 50 SATA 300.000 80 Generic 250.000
21 GigE 500.000 51 SATA 600.000 81 Generic 255.000
22 GPON 187.500 52 SDI 74.250 82 Generic 260.000
23 Interlaken 132.813 53 SDI 148.500 83 Generic 265.000
24 Interlaken 195.313 54 SDI 297.000 84 Generic 270.000
24 www.xilinx.com KC724 IBERT Getting Started Guide
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SuperClock-2 Frequency Table

Table 1-2: Si570 and Si5368 Frequency Table (Contd)

Address Protocol Frtznqnlll_'ezr)lcy Address Protocol Fr((alc\]nl:'ezr)\ cy Address Protocol Frtz'?nlll_'ezr)lcy
25 Interlaken 265.625 55 SDI 594.000 85 Generic 275.000
26 Interlaken 390.625 56 SMPTE435M 167.063 86 Generic 280.000
27 Interlaken 531.250 57 SMPTE435M 334.125 87 Generic 285.000
28 OBSAI 76.800 58 SMPTE435M 668.250 88 Generic 290.000
29 OBSAI 153.600 59 XAUI 78.125 89 Generic 295.000
90 Generic 300.000 103 Generic 365.000 116 Generic 430.000
91 Generic 305.000 104 Generic 370.000 117 Generic 435.000
92 Generic 310.000 105 Generic 375.000 118 Generic 440.000
93 Generic 315.000 106 Generic 380.000 119 Generic 445.000
94 Generic 320.000 107 Generic 385.000 120 Generic 450.000
95 Generic 325.000 108 Generic 390.000 121 Generic 455.000
96 Generic 330.000 109 Generic 395.000 122 Generic 460.000
97 Generic 335.000 110 Generic 400.000 123 Generic 465.000
98 Generic 340.000 111 Generic 405.000 124 Generic 470.000
99 Generic 345.000 112 Generic 410.000 125 Generic 475.000

100 Generic 350.000 113 Generic 415.000 126 Generic 480.000
101 Generic 355.000 114 Generic 420.000 127 Generic 485.000
102 Generic 360.000 115 Generic 425.000
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& XILINX.

Creating the GTX IBERT Core

The Vivado Design Suite 2014.4 is required to rebuild the designs shown here.

This section provides a procedure to create a single Quad GTX IBERT core with integrated
SuperClock-2 controller. The procedure assumes Quad 115 and 12.5 Gb/s line rate, but

cores for any of the GTX Quads with any supported line rate can be created following the
same series of steps.

For more details on generating IBERT cores, see Vivado Design Suite User Guide:
Programming and Debugging (UG908) [Ref 3].

1. Start the Vivado Design Suite.

2. Inthe Vivado Design Suite window, click Manage IP (highlighted in Figure 1-20) and
select New IP Location.

File Flow Tools Window Help

VIVADO! o o

Quick Start

AT

5N

Create New Project

a
. ?J

Open Praoject

Tasks

=

Manage IP

Open Hardware Manager

ﬁ ii

Quick Take Videos

Information Center

Documentation and Tutorials

g__

Open Example Project

i

Xilinx Tl Store

E w;i

Release Notes Guide

& XILINX

ALL PROGRAMMABLE.

B Td Console

Figure 1-20: Vivado Design Suite Initial Window
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& XILINX.

Creating the GTX IBERT Core

When the Create a New Customized IP Location dialog window opens (not shown),
click Next.

In the Manage IP Settings window, select a part by clicking the (...) button next to the
Part field. A Select Device window is displayed. Use the drop-down menu items to
narrow the choices. Select the xc7k325tffg900-3 device (Figure 1-21). Click OK.

#L Select Device (52
Specify Filter
|@P§rts| Product categoryy All - Package | ffg300 -
H Boards Family] Kintex-7 | Speed grade | -3 -
Sub-Family] All Remaining + | Temp grade | All Remaining -
Reset All Filters |
Search: | O~
I/Q Fin Available LuT : Blodk Gb
Pl Count I0Bs Elements ¥k daps RAMs ehs Transcei
T wc7k325tffa900-3 l203800 l407s00 l44s
5 wcTh410tffig900-3 900 500 254200 508400 795 1540 16
¥ 1 + O
ok || Cancel |

ug931_c1_21_121113

Figure 1-21: Select Device
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p

5. Back on the Manage IP Catalog window, select Verilog for Target language, Vivado
Simulator for Target simulator, Mixed for Simulator language, and a directory to save
the customized IP (Figure 1-22). Click Finish.

Note: Make sure the directory name does not include spaces.

ﬁl*..f_:. Mew IP Location @
Manage IP Settings .
Set options for creating and generating IP. ‘\i_‘
Part: @ %c7k325tF0900-3 (active) (=]
Target language: Verilog -
Target simulator: Vivado Simulator -
Simulator language: | Mixed -
IP location: H:/IBERT/KC724) (-]

Mext = Finish ] [ Cancel

ug931_c1_22_121113

Figure 1-22: Manage IP Settings
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& XILINX. Creating the GTX IBERT Core

6. In the IP Catalog window, open the Debug & Verification folder, open the Debug
folder, and double-click IBERT 7 Series GTX (Figure 1-23).

Jﬁ IP Catalog X I E
Search: |C1_v
a1
Mame AXI4 Status License VLMY

&
%
i
%
@s

»

- Alliance Partners

[ Automotive & Industrial

L'j AXT Infrastructure

([ BaselP

[ Basic Elements

L'j Communication & Metworking

E'E‘.‘ Debug & Verification

= Debug

: -3 TBERT 7 Series GTH Included wilim. col

iF IBERT 7 Series GTF Incuded yilina¢. col

""" |F'rndu::h'un |Ir1c|uded |:<i|inx.cn -
Induded 1

-§F IBERT Lllh ascale GTH

=3

Induded
--JF IBERT Ulirascale GTY Induded wilir. con
-1F ILA (Integrated Logic Analyzer) AXI14, AXI4-Stream Production Included wilin. cot
--1F JTAG to AXI Master AXI4 Production Induded wilir. col
-4 VIO (Virtual Input/Output) Production Included wilire. col

I [~ Digital Signal Processing
! [~ Embedded Processing
"E:".‘ FPGA Features and Design
L'j Math Functions | M
E‘ Memories & Storage Elements

"I.':",' Standard Bus Interfaces &
1| I 3

UG931_c1.23_110314

Figure 1-23: IP Catalog
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7. A Customize IP window opens. In the Protocol Definition tab, change

LineRate(Gb/s) to 12.5 and change Refclk (MHz) to 125.00. Keep defaults for other
fields (Figure 1-24).

g: Customize [P @
IBERT 7 Series GTX (3.0) ':lj
m Documentation |5 IP Location L Switch to Defaults

Show disabled ports Companent Name ibert_?serieslgtx_ﬂ
- Protocol Definition | Protocol Selection | Clock Settings | Summary
Silicon Version
(@ General ES/Production
() Initial ES
The maximum number of quads available for this device is 4
Mumber of Protocols 1 -
RxM_I[3:0] Protocol LineRate{Gbps) DataWidth Refdk(MHz) Quad Count Quad PLL
FP_13:0] THN_O[3:0] Custom 1 - |1z.5 |32 v | 125000 W | 1 v
GTREFCLKO_I[0:0]  T*P_0O[3:0]
GTREFCLEL_I[0:0] RXOUTCLE_O
SYSCLK_T
4 [ < i 3
OK ] [ Cancel

ug931_c1_24_121113

Figure 1-24: Customize IP - Protocol Definition
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& XILINX.

Creating the GTX IBERT Core

8. In the Protocol Selection tab, use the Protocol Selected drop-down menu next to
QUAD_115 to select Custom 1/ 12.5 Gbps (Figure 1-25).

-

_EDZ Customize [P

IBERT 7 Series GTX (3.0)

ﬁ Documentation |5 IP Location L Switch to Defaults

[¥] Show disabled ports

RN _I[3:0]
FxP_I[3:0] THN_0[3:0]
GTREFCLED_I[0:0]  TxP_0[3:0]

GTREFCLKL_I[0:0] RMOUTCLE_O
SYSCLK_T

Compenent Name | ibert_7series_gtx_0

Protocal Deﬁhitio_n " Protocol Selection | Clock Settings | Summary ;

Please select Protocol-Quad combination

GT¥ Location Protocol Selected Refdk Selection TXUSRCLK Source

QUAD_115 Custom 1/ 12.5 Gbps | MGTREFCLED 115 + | Channel 0 ¥
QUAD_116 MNone = | Mone w | Channel 0

QUAD_117 MNone - | Mone ~ | Channel 0

QUAD_118 Mone = | Mone w | Channel 0

OK ] | Cancel

Figure 1-25: Customize IP - Protocol Selection
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9. Inthe Clock Settings tab, select DIFF SSTL15 for the I/O Standard, enter C25 for the
P Package Pin, enter B25 for the N Package Pin (the FPGA pins that the system clock
connects to), and make sure the Frequency (MHz) is set to 200.00 (Figure 1-26). Click
OK. Click Generate in the next window to generate the output products.

ﬁ Custemize IP
IBERT 7 Series GTX (3.0)

ﬁ Documentation |5 IP Location L) Switch to Defaults

[¥] Show disabled ports

R _I[3:0]
RiP_I[3:0] TeM_0[3:0]
GTREFCLKO_I[0:0]  T¥P_O[3:0]
GTREFCLKL_I[0:0]  RXOUTCLE_O
SSCLK_T

1 -

Component Name |ibert_7series_gtx_0

Protocol Definition | Protocol Selection '(hckSetﬁngs-f Summary

RXOUTCLK Probe

[ Add RXOUTCLK Probes

Clock Type Source 1/0 Standard P Package Pin

M Package Pin Frequency({MHz)

System Clock  [External ~ DIFF 55TL15 - |cas

B25 200,00 |

System Clock Termination Settings

[ Enable DIFF Term

Figure 1-26: Customize IP - Clock Settings

OK ] I Cancel
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& XILINX.

Creating the GTX IBERT Core

10. Back on the Manage IP Catalog window, in the Sources window, right-click the IBERT
IP and select Open IP Example Design (Figure 1-27). Specify a location to save the
design, click OK, and the design opens in a new Vivado Design Suite window.

Project Manager - xc7k325tfg200-3

Sources

zaEeE

EHEP (1)
B

[ Source File Properties. ..

Ctrl+E

if Re-customize IP...

Reset Qutput Products. ..

I

[I's]

rafe
. U= 1]

Copy IP...

Generate Qutput Products...

Out-of-Context Settings...

B Open IP Example Design. ..

[P Documentation

— — —
Cony Shar
Y ol

{2 ReportIP Status

dl o
UL

i

m

e Diprdaet
(] ]

[ | & B0 @ W | W | AR A | 2

#  Remove IP from Project...

Delete

Set Lsed In...

B  Add Existing IP..,

{F IP Catalog X

Search: | L~
a1

MName
(-5 Alliance Partners
[ Automotive & Industrial
L'j AXI Infrastructure
L'j BaselP
--If-j Basic Elements
"E.‘ Communication & MNetworking
=[5 Debug & Verification
[ Debug
- §F IBERT 7 Series GTH

IBERT 7 Series GTP

$F IBERT 7 Series GTZ
-4 IBERT Ultrascale GTH
-4 IBERT Ultrascale GTY
~{F 1A (Integrated Logic Analyzer)
~4F ITAG to AXI Master
- 4F VIO (Virtual Input/Output)
[ Digital Signal Processing
[#][= Embedded Processing
[#-[ FPGA Features and Design
[ Math Functions
[#)[= Memories & Storage Elements
[ Standard Bus Interfaces

i m
UG931_c1_27_110314

Figure 1-27: Open IP Example Design
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11. Inthe new window, select Tools > Run Tcl Script. In the Run Script window, navigate
to add_scm2. tcl in the extracted files and click OK. The SuperClock-2 Module

Design Sources and Constraints are automatically added to the example design
(Figure 1-28).

| Project Manager - ibert_7series_gtx_0_example

Sources (|

Q= meh B
[=-{= Design Sources (4)
i [-be gy example_ibert_7series_gbx_0 (=xample_ibert_Tzeries_ghe
FE-#8 top_scm2 (top_scm2.v) (2)
P E-EText (2)
-"._I Constraints (2]
-5 Simulation Sources (4)

Ma
*

1| i |
IP Sources |Libraries |Cumpile Order | :

& Sources L ' Templates ]

Properties 0= =

« > Fx

UG931_c1_28_022514

Figure 1-28: Sources after Running add_scmz2.tcl
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& XILINX.

Creating the GTX IBERT Core

12. The SuperClock-2 source code needs to be added to the example IBERT wrapper.
Double-click example_ibert_7series_gtx_0.v in Design Sources to open the
Verilog code of the example. Add the top-level ports from top_scm2 . v to the module
declaration and instantiate the top_scm2 module in the example IBERT wrapper
(Figure 1-29). The code is also available in scm2_merge_source. txt. Click

File > Save File.

T Project Summary ¥ | @8 example_ibert_7series_gtx_ 0w * X

Owe =

EE t_Teeries_gtx_0_sxample.srcs/sources_1/imports fexample_design/example_ibert_7series_gtx_0.v

03

J
&
&
f;)
[
&
¥

31
32
33
34
35

input ["C_REFCLEKS_USED-1:0]
input ["C_REFCLES_USED-1:0]
input [*C REFCLES USED-1:0]

input :0] usrclk_p,
input :0] usrclk_n,
inout i2c_sda,

-
&
-
&

input i2c scl,

cutput [5:0] sclk_out,
input [§:0] seclk_in,
cutput [2:0] sclk_clk p,
cutput [2:0] sclk_clk n

wire
wire
wire
wire

wire

top_scm2 u_scm2
{

.8ysclk_i(sysclk_ i),
.usrclk_p(usrclk p),
.usrclk_n(usrclk_m),
.12c_sda(ilZc_sda),
.i2c_scl{iZec_scl),
.3clk_out(sclk_out),
.3clk_in{sclk_in),
.3clk_clk p(sclk_clk p),
.3clk_clk n(sclk_clk n)

GIREFCLEON_TI,
GIREFCLKIP T,
GIREFCLKIN_ T,

gtrefclk0_i:

gtrefclkl _i:
refclk0_1i;
refclkl_i;

sysclk_i;

-

m

2

ug931_c1_29_121113

Figure 1-29: SuperClock-2 in the Example IBERT Wrapper
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13. In the Sources window, Design Sources should now reflect that the SuperClock-2
module is part of the example IBERT design.

Project Manager - ibert_7series_gh_0_example

M
=

Sources —d

az=we RE

=i Design Sources (3)
[}-we s example_ibert_7series_gbe_0 (example_ibert Tseries gt 0]
)-8 u_scm2 - top_sem2 {top_scm2.v) (2)
! belBu_freq_counter - freq_counter (freq_counter.v)
- "-'Elu _vio_sdk2_control - vio_sck2_control (vio_sdk2_contraol.v)
----- d_.}l]u vio1 - vio_scm2 {vio_scm 2, xd)
-8 u_i2c_sdk2_control -i2c_sdk2_control {i2c_sdk2_contro
R ﬂ u_i2c_sdk2_control - i2c_sck2_control (i2c_sdkZ_contro
I ALFu_ibert_core -ibert_Tseries_gtx_0 (ibert_Tseries_gtx_0.xc)
= Text (2)
-5 Constraints (2]
I Simulation Sources (1)

[ Properties

1 1 kO

IF Sources |Libraries |Cum|:rile Order |

4% Sources L & Templates ]

UG931_c1_30_051414

Figure 1-30: Design Sources File Hierarchy
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& XILINX.

Creating the GTX IBERT Core

14. Click Run Synthesis in the Flow Navigator to synthesize the design.

4 Project Manager
) Project Settings
a¥ Add Sources

1F IP Catalog
IP Integrator
Simulation
RTL Analysis

4 Synthesis
@. Synthesis Settings

$» Run Synthesis

5’3 Open Synthesized Desgn

Implementation

Program and Debug

UG931_c1_31_031814

Figure 1-31: Run Synthesis
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15. When the synthesis is done a Synthesis Completed window opens. Select Open
Synthesized Design and click OK (Figure 1-32).

"Synthesis Completed 5

e Y
"o" Synthesis successfully completed.
\\ w

Next
() Run Implementation
Open Synthesized Desigr

(*) View Reports

7] Don't show this dialog again

[ox [ concel |

UG931_c1_32_031914

Figure 1-32: Synthesis Completed
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& XILINX. Creating the GTX IBERT Core

16. When the Synthesized Design opens, select dbg_hub in the Netlist window, and then
select the Debug Core Options tab in the Cell Properties window and change
C_USER_SCAN_CHAIN* to 3 (Figure 1-33). Click File > Save File Constraints.

Synthesized Design - synth_1 | xc7k325tfg200-3 (active)

M
®

Metlist S |

= 7

& example_ibert_Tseries_gte_0

= Nets (130)

| Leaf Cells (24)

u_jbert_caore (bert_Tseries_gte_0)
E-{@] u_som?2 (top_scm?)

& sources-, 3 Metlist

Source File Properties — O ¢ =

« +EI5

$¥ dbg_hub

C_USER_SCAN_CHAIN® B |
C_CLK_INPUT_FREQ_HZ 300,000,000
C_ENABLE_CLK_DIVIDER &l

Select an option above to see a description of it

General | Properties | Debug Core Options | Debug Ports | Statisth 4 ¢ 5

UG931_c1_33_082614

Figure 1-33: Debug Core Options for dbg_hub
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17. In the Program Manager window under Program and Debug, click Generate
Bitstream. A window pops up asking if it is Okay to launch implementation. Click
Yes.

o |, There are noimplementation results available, Okay to launch implementation? 'Generate
a."\/ Bitskream' will aukomatically skart when implementation completes,

[ ] Don't show this dialog again

fes Mo |

UG931_c1_34_121213
Figure 1-34: Generate Bitstream

18. When the Bitstream Generation Completed dialog window appears, click Cancel
(Figure 1-35).

Bitstream Generation Completed @

|0I Bitstream Generation successfully completed.

Mext

@ Open Implemented Design
_) View Repaorts

~ Open Hardware Manager

[7] Don't show this dialog again

UGY31_c1_35_051414

Figure 1-35: Bitstream Generation Completed

19. Navigate to the . . \ibert_7series_gtx_0\ibert_7series_gtx 0_example\
ibert_7series_gtx_0_example.runs\impl_1 directory tolocate the generated
bitstream.
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Appendix A

Additional Resources

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see the
Xilinx Support website.

For continual updates, add the Answer Record to your myAlerts.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up to date information related to the KC724 board and its documentation is
available on these websites:

Kintex-7 FPGA KC724 Characterization Kit
Kintex-7 FPGA KC724 Characterization Kit documentation
Kintex-7 FPGA KC724 Characterization Kit Answer Record (AR 43390)

These documents provide supplemental material useful with this guide:

1. KC724 Kintex-7 FPGA GTX Transceiver Characterization Board User Guide (UG932)

2. HW-CLK-101-SCLK2 SuperClock-2 Module User Guide (UG770)

3. Vivado Design Suite User Guide: Programming and Debugging (UG908)

4. LogiCORE IP Integrated Bit Error Ratio Tester (IBERT) for 7 Series GTX Transceivers Product

Guide for Vivado Design Suite (PG132)
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Appendix B

Warranty

THIS LIMITED WARRANTY applies solely to standard hardware development boards
and standard hardware programming cables manufactured by or on behalf of Xilinx
(“Development Systems”). Subject to the limitations herein, Xilinx warrants that
Development Systems, when delivered by Xilinx or its authorized distributor, for ninety
(90) days following the delivery date, will be free from defects in material and
workmanship and will substantially conform to Xilinx publicly available specifications for
such products in effect at the time of delivery. This limited warranty excludes:

(i) engineering samples or beta versions of Development Systems (which are provided
“AS IS” without warranty); (ii) design defects or errors known as “errata”;

(iii) Development Systems procured through unauthorized third parties; and

(iv) Development Systems that have been subject to misuse, mishandling, accident,
alteration, neglect, unauthorized repair or installation. Furthermore, this limited warranty
shall not apply to the use of covered products in an application or environment that is not
within Xilinx specifications or in the event of any act, error, neglect or default of Customer.
For any breach by Xilinx of this limited warranty, the exclusive remedy of Customer and
the sole liability of Xilinx shall be, at the option of Xilinx, to replace or repair the affected
products, or to refund to Customer the price of the affected products. The availability of
replacement products is subject to product discontinuation policies at Xilinx. Customer
may not return product without first obtaining a customer return material authorization
(RMA) number from Xilinx.

THE WARRANTIES SET FORTH HEREIN ARE EXCLUSIVE. XILINX DISCLAIMS ALL
OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT, AND ANY WARRANTY THAT
MAY ARISE FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR USAGE
OF TRADE. (2008.10)

Do not throw Xilinx products marked with the “crossed out wheeled bin” in the trash.
Directive 2002/96/EC on waste electrical and electronic equipment (WEEE) requires the
separate collection of WEEE. Your cooperation is essential in ensuring the proper
management of WEEE and the protection of the environment and human health from
potential effects arising from the presence of hazardous substances in WEEE. Return the
marked products to Xilinx for proper disposal. Further information and instructions for
free-of-charge return available at: www.xilinx.com\ehs\weee.
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